
APPLYING GEOSCIENCE TO AUSTRALIA’S MOST IMPORTANT CHALLENGES www.ga.gov.au

Prepared for the Australian Government Department of Climate Change and Energy Efficiency July 2012

Catalogue of Timor-Leste datasets and 
data records
Vulnerability assessment of climate change impacts on groundwater 
resources in Timor-Leste

Samantha Dawson, Luke Wallace and Baskaran Sundaram

Record 2012/56   |   GeoCat 73845



 



Catalogue of Timor-Leste datasets  
and data records 
 

Vulnerability assessment of climate change 
impacts on groundwater resources in  
Timor-Leste 
 
 
 
PREPARED FOR THE AUSTRALIAN GOVERNMENT DEPARTMENT OF  
CLIMATE CHANGE AND ENERGY EFFICIENCY 
 
BY GEOSCIENCE AUSTRALIA 
 
 
July 2012 
 
by 
 
 
Samantha Dawson, Luke Wallace and Baskaran Sundaram  
 
 
 
 
 
 
 
 
 
 
 

 
 

               



Disclaimer: 
 
This report has been prepared by Geoscience Australia for the Australian Government, represented 
by its Department of Climate Change and Energy Efficiency (DCCEE).  Funding for the preparation 
of the report was made available from the Pacific Adaptation Strategy Assistance Program, delivered 
by DCCEE.  
 
The report includes the views and recommendations of third parties and does not necessarily reflect 
the views of the Australian Government, or indicate a commitment to a particular policy or course of 
action.  
 
While reasonable efforts have been made to ensure the accuracy, completeness and reliability of the 
material contained in this document, neither the Commonwealth nor Geoscience Australia warrant 
that the information contained in this report is free from errors or omissions.  The Commonwealth 
and Geoscience Australia do not accept any form of liability, be it contractual, tortious or 
otherwise, for the contents of this report or for any consequences arising from its use or any reliance 
placed upon it.  The material in this document is provided for general information only, and on the 
understanding that the Australian Government is not providing professional advice on a particular 
matter.  Before any action or decision is taken on the basis of this material the reader should obtain 
appropriate independent professional advice. 
 
Copyright notice: 
 
© Commonwealth of Australia 2012 
 
This work is licensed under the Creative Commons Creative Commons Attribution 3.0 Australia 
Licence. To view a copy of this license, visit http://creativecommons.org/licenses/by/3.0/au/.  
 
The Department of Climate Change and Energy Efficiency asserts the right to be recognised as the 
copy right owner of the original material in the following manner:  
 
 

 
© Commonwealth of Australia (Department of Climate Change and Energy Efficiency) 2012. 
 
 
ISSN 1448-2177 
ISBN 978-1-922103-65-9 (PDF, English) 
ISBN 978-1-922103-66-6 (Print, English) 
ISBN 978-1-922103-77-2 (PDF, Tetum) 
ISBN 978-1-922103-78-9 (Print, Tetum) 
 
GeoCat # 73845 
 
 
Bibliographic reference: Dawson, S., Wallace, L. and  Sundaram, B., 2012. Catalogue of Timor-
Leste datasets and data records - Vulnerability assessment of climate change impacts on 
groundwater resources in Timor-Leste. Record 2012/56. Geoscience Australia: Canberra.  

 



Catalogue of Timor-Leste datasets and data records 

Contents 
 
 
Datasets and Data Records....................................................................................................................1 

Data Documentation .........................................................................................................................1 
Metadata........................................................................................................................................1 
Readme files .................................................................................................................................2 

Data capture ......................................................................................................................................2 
Administration and infrastructure .................................................................................................3 
Climate..........................................................................................................................................3 
Earth observations and imagery....................................................................................................3 
Elevation .......................................................................................................................................3 
Hydrogeology and groundwater....................................................................................................4 
Hydrology .....................................................................................................................................4 
Geology.........................................................................................................................................4 
Land information ..........................................................................................................................4 
Natural habitat...............................................................................................................................4 
Non-georeferenced maps ..............................................................................................................5 
Attachment 1: Data catalogue for data collected in Timor-Leste .................................................6 
Attachment 2: ‘Readme’ files for the GA ArcGIS project..........................................................12 
Attachment 3: Example of a metadata record from the Timor-Leste project .............................35 

 
 

III 



Catalogue of Timor-Leste datasets and data records 

IV 

 
 
 



Catalogue of Timor-Leste datasets and data records 

Datasets and Data Records  
 
 
The aim of the ‘Assessment of Climate Change Impacts on Groundwater in Timor-Leste Project’ is 
to build Timor-Leste water agencies’ capacity for assessing, monitoring and managing groundwater 
resources in a changing climate. The project is an Australian Government initiative under the Pacific 
Adaptation Strategy Assistance Program. This program is being managed by the Australian 
Government Department of Climate Change and Energy Efficiency (DCCEE) and is part of the 
International Climate Change Adaptation Initiative. This report presents the datasets collected for the 
project, new metadata for these datasets and a process for the upkeep of datasets into the future. 
 
Collation and interpretation of existing national datasets was essential to the assessment and 
understanding of Timor-Leste groundwater systems. Datasets were collected in Timor-Leste from a 
number of government departments. The Agriculture and Land Geographic Information System 
(ALGIS) section of the National Directorate of Policy and Planning, Ministry of Agriculture and 
Fisheries had the largest amount of data pertinent to this project. All of the datasets collected are 
relevant and important; however, much of the data came from past diverse foreign projects and there 
was no data catalogue present at any department, nor was any metadata attached to the datasets to 
identify what they were or ‘readme’ files in any of the project folders. This information needed to be 
created by Geoscience Australia before the data could be used in an effective manner (Figure 1) – 
the data catalogue, ‘readme’ files and an example metadata are attached. 
 
Data was limited, including groundwater information, and of the data that was available the quality 
was often low. Firstly, the data available in Timor-Leste is limited due to the political history: 1) 
limited data is available from Portuguese times; 2) all data collected during the Indonesian 
government period has not been made available to the Timor-Leste government; and 3) of the data 
that has been collected since independence in 1999, a large proportion was lost in the 2006 riots. 
What data is left is largely sporadic and its usefulness is weakened by the lack of metadata or any 
information on how the data was made and/or collected. For example, although little to no 
groundwater monitoring has been done in Timor-Leste, there was an Asian Development Bank 
report, published in 2004, that assessed the water resources of the country, including groundwater. 
While copies of this report can still be found, all of the background data, numbers, equations and 
maps that went into this report were lost during the 2006 riots. Similarly, most of the datasets 
collected were incomplete and this created several issues when designing a methodology to 
investigate groundwater. 
 
 
DATA DOCUMENTATION 
 
Metadata 
Metadata is essentially ‘data on the data’; it incorporates such information as what the dataset is, 
when it was made and for what purpose, who the author was, how often it should be updated, when 
it was last updated, scale, accuracy, geographic projections, file formats and other useful 
information. In ArcGIS all shapefiles and rasters have an automatically generated metadata section 
attached to them, which can be found and updated in ArcCatalog. The importance of metadata 
cannot be overstated, especially when considering use of the data beyond the life of a project. For a 
GIS user the metadata is the first point of reference to assess if a dataset is useful, if the information 
that went into making it and the accuracy levels are acceptable, who the author was and therefore 
who to attribute the data to, whether this data can actually be used or if use is restricted and if the 
information is up-to-date or if new data will need to be collected. Therefore, if data is going to be 
useful after the initial project that made them has ended, it is essential that at least some amount of 
the metadata section of an ArcGIS file is completed.  
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None of the shapefiles and rasters collected had any information in the metadata section and we were 
largely unable to ascertain when the data was made, who by, what scale it was in and what purpose 
the data was originally made for. 
 
Before the data could be analysed for this project, a data catalogue needed to be compiled and 
metadata for each file ascertained and documented as far as possible. Both of these tasks were time 
consuming and demanded a high level of attention to detail. Essentially it required examining and 
researching each of the 69 spatial datasets that were collected during the project, assigning them to a 
logical position in the data catalogue and inserting any relevant metadata that could be found or 
deduced from an examination of the file. Despite the large quantity of unknown details surrounding 
the datasets, these two tasks have now been completed to the highest standard possible under the 
circumstances. It should be noted that much of the metadata and data catalogue is derived from 
assumptions that we could draw from examination of the data. This throws doubt on some of the 
attributes inserted into both the data catalogue and the metadata, however it is the best attempt 
possible at this time. 
 
Readme files 
For datasets, ‘readme’ files are widely recognised within the GIS community as an extremely useful 
method of recording files and GIS methods used in a project. Essentially a ‘readme’ file is a text file 
that is found in each of the folders/category areas within a GIS project. These files generally contain 
a summary of what the folder contains and its purpose in the project, and it may also give 
descriptions of each file, where the data is from and the specific steps used to generate the data. This 
is useful both in the project lifetime and past it, especially if the GIS administrator records the 
methods used. There are multiple reasons for this but the most important ones are if any files, or the 
entire folder, are corrupted the folder or files can be re-built using the information in the ‘readme’ 
file.  
 
Beyond the life of the project, having methods in the ‘readme’ files means that anyone else using the 
data can easily follow and replicate the steps that were taken to produce the outputs of the project. 
This is helpful in understanding the project more fully, applying methods to other similar projects 
and assessing the quality and usefulness of past projects for whatever the current project may be.  
 
Having complete ‘readme’ files greatly enhances the usability and ease of use of GIS files within a 
project. For each of the categories used in the project, those discussed above and others developed 
specifically for the project, a ‘readme’ file has been created, including summary of the folders, file 
descriptions and explicit, step-by-step methods for how any data created was made. 
 
The data catalogue, metadata sections and ‘readme’ files have been completed for the project thus 
far. The data catalogue (attachment 1) has been completed for all of the data collected in the country. 
There were 69 useable files all of which have been examined and assessed. The ‘readme’ files 
(attachment 2) are up to date for all folders, both those described above and the new folders that 
have been created as part of the project. This includes detailed methodology on the datasets created. 
Metadata sections have been completed for the entire project as of January 2011 and include both the 
collected files and the files produced by the project, in total over 100 files. Each metadata section is 
between 3 and 5 pages long (see attachment 3 for an example metadata section). The method used to 
achieve this is presented in Figure 1 below. 
 
 
DATA CAPTURE 
 
Despite the number of issues associated with data collection, sufficient data was collected so that the 
project could move forward. The data was categorised and documented in a data catalogue, which is 
essentially a list of data (or files) that contains information such as file name, file location, summary 
description of the data, accuracy levels, scales and projects the data was used for. This data 
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catalogue becomes a reference file and allows anyone to quickly and easily search for and locate 
data that is relevant to them.  
 
The details of the various datasets collected during phase 1 of the project are presented in 
Attachment 1 and a brief summary is outlined below, divided into their respective categories within 
the data catalogue 
 
Administration and infrastructure 
This dataset is fairly complete. There is data for major roads, minor roads and tracks, major and 
minor towns and there are a number of shapefiles detailing the administration boundaries (national 
borders, districts, subdistricts, etc), although there is no cadastral data and several of the datasets 
conflict in the areas defined and standard naming systems. There is also a set of data which seems to 
be related to hospital and clinic management and resourcing, but as the names of these files have no 
particular meaning and there is no metadata, it is difficult to be sure. 
 
Climate 
The climatic data is sporadic and has only been collected for a short time. There is some climate data 
which has recently been collected by the National Directorate for Water Resources, but this data is 
stored in a format that was inaccessible by GA software .There is CMORPH/NOAA data, which 
holds raster maps of daily precipitation from 2003-2008 for the world at a scale of 0.25 degrees. This 
data may be useful, although on the Timor-Leste scale it would be fairly coarse and the time it would 
take to process this data would be immense. The Timor-Leste Ministry of Agriculture, Forests and 
Fisheries has an Agro-Meteorology Section which, from 2004 to 2009, kept a record of daily 
temperature minimum, maximum and mean, relative humidity minimum, maximum and mean, wind 
speed and evapotranspiration at 12 locations across the country. This would be a very valuable 
dataset but the recordings are sporadic, with some months having days missed, others with only one 
or two days recorded and others where months went by without a single recording. Also, the 
locations given for the monitoring stations are incorrect in at least three cases, casting doubts on the 
quality of the rest of the data. There are shapefiles of the average annual rainfall and temperature 
which are coarse contour maps, however due to the lack of metadata we don’t know when these 
maps were made, what years they are the average for, or if, and by how much, the averages may 
have changed since they were made. Another dataset that could potentially be useful was a polygon 
map which, from examining the attribute table, may be a division of how water is used in areas 
across the country. As there is no metadata and no useful descriptive information in the dataset name 
or attributes the data could not be used by this project. 
 
Earth observations and imagery 
There are a large number of remote sensing images in this category. These include air photos of the 
whole country, a topographic map of the whole country, a space shuttle shaded relief which shows 
the relief of the country, satellite images covering around three quarters of the country and a 
LANDSAT image set which shows the country east of Dili. Some of these images are potentially 
very useful, but again there is no information on when the images were taken, by whom and for what 
purpose. As remote sensing analysis is beyond the scope of this project, this dataset is of limited use 
here. 
 
Elevation 
There was a reasonable amount of usable data collected for this category but without metadata, it is 
of unknown source and accuracy. Data collected includes contour lines, bathymetric lines, elevation 
raster (SRTM 3-second DEM –a  reliable and standard dataset) for the whole of the country and 
surrounding area, polygon shapefiles dividing elevation and slope into high medium and low, a 
raster of erodible areas and a separate elevation raster with no information on its source. Of this the 
SRTM 3-second DEM (Digital Elevation Model) is probably the most useful as SRTM datasets are 
used worldwide, the source is known and therefore the dataset reliable. 
 

3 



Catalogue of Timor-Leste datasets and data records 

Hydrogeology and groundwater 
There were no datasets collected for this category, although it is believed that some work was done 
during the Indonesian period. An Asian Development Bank (ADB) report on water resources was 
completed in 2004, however all the background data and maps from this project are missing 
Previous to this project’s work there was no hydrogeology map and, while there was some 
knowledge of the high yielding aquifers, the distribution and understanding of them was limited 
despite the high level of use and dependence on these resources in Timor-Leste. 
 
Hydrology 
There was a small amount of GIS data available in this category. Although the Norwegian 
government is currently working with the Timor-Leste Directorate of Water Resource Management 
on surface water resources and management, this project does not use GIS and hence there are no 
GIS files available. Data collected included a seamask (polygon depicting area of sea), polygons of 
the waterbodies, watersheds and braiding rivers (all of the major rivers in Timor-Leste are braiding 
rivers) and a polyline dataset showing the minor rivers.  
 
Geology 
There was a reasonable amount of data available in this category, which is fortunate as the lack of 
groundwater data means that geology data needs to be heavily relied upon. Although, there is still a 
lack of metadata, meaning that it is difficult to ascertain where the data came from, who it should be 
attributed to and what degree of confidence can be placed in it.  
 
First, there is the ‘ESCAP’ map, which was published by the UN. This map exists as an undigitised 
picture as it was scanned in from a hardcopy belonging to the Timor-Leste directorate for geology 
department. There is a polygon shapefile titled ‘geology’ which was stored in several departments. 
Although it is coarse, this map has some detail in the attribute table and could be used, even though 
the source of the data is not known. This map appears to be a digitised version of the ESCAP map, 
as the polygons roughly match, although the legends use different classification systems. 
 
Another geology polygon shapefile was collected. It has no information on who created it or what 
the information source was, but the level of detail is much greater than the other geology map. The 
attribute table is also much more descriptive. The finer detailed map is believed to be largely based 
on the work of Prof. Audley-Charles and Tobing, with a portion in the north being the work done by 
Berry. It is not known who compiled the digital version of this map or combined the work of the 
various sources, nor when or to what purpose this map was made.  
 
Land information 
There is a reasonable amount of data in this category. The files are all polygon datasets, except for a 
raster map depicting areas of high erodibility made by Nicholas in 2008. Of the polygon datasets 
there are files depicting areas of high fertility, a file which is either showing current land uses or 
potential future land uses, a file defining land covers, one showing areas where rice fields are, 
another dividing slopes into S, F or M (we assume this means Steep, Flat or Medium) and one on the 
soil orders, suborders and greater classifications. A number of datasets could not be deciphered as to 
their origin or purpose. While some of these datasets are important in helping depict and describe 
background information, their usefulness is decreased by the lack of metadata and information on 
what the datasets were meant for or where they are derived from. 
 
Natural habitat 
There are only a small number of datasets in this category, namely those that seem to have been 
created when designating national parks and identifying areas of environmental significance. 
Although there is again the problem of metadata, there are also issues surrounding ambiguous 
naming of files which makes their purpose and potential uses difficult to determine. The first data set 
is named “BVA” and it seems to show either protected areas or areas that could potentially be 
protected/are of high environmental importance. A second dataset, named “ESM”, divides the 

4 



Catalogue of Timor-Leste datasets and data records 

5 

country into areas of very high, high, medium and low sensitivity, and we assume this means 
environmental sensitivity but that is not certain. A third file, named ImportantBirdArea, presumably 
depicts areas that are of high importance in terms or the amount or type of birdlife found there. The 
remaining two files located are “Landcover”, depicting landuse across the country, and “Timor 
Coastal Marine Habitats Nth”, which divides the northern coastline and the area off the coastline into 
marine habitats, for example, sand beach, mangrove forest and coral reef. 
 
Non-georeferenced maps 
We identified a number of images which can be displayed in ArcMap but have not been 
georeferenced (given co-ordinates so they can be displayed with other ArcGIS files). They appear to 
be scanned maps which have not been georeferenced. The most important of these is the geology 
ESCAP map which was scanned during the collection by Geoscience Australia in the current project 
from the geology department and has since been georeferenced. Other maps of less pertinence to this 
project include: agricultural areas also showing where sampling surveys were undertaken in 2008; 
agroclimatic zones; annual rainfall (which is the same as the GIS file described above); bathymetry 
of what appears to be the southern coastline; a map named forest_status which depicts areas of 
settlements, where forests are and what they are used for; soil taxonomy; subdistricts and a map 
named ‘Copy of steve_dunn’, but titled ‘The Proposed Refrigerator (cold chain) Locations by Sub 
District’ which shows basic locations with a few points identified. This last map illustrates why 
naming, metadata and data catalogues are all important – without these, this map loses usability and 
as we would not be able to tell what the map was depicting.  
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Attachment 2: ‘Readme’ files for the GA ArcGIS project  
 
Files are arranged by alphabetical order of the file they are describing: These are the ‘readme’ files 
for the entire project as of January 2011. They were made at the beginning of the project and 
regularly updated. 
 
 
README for ‘admin&infra’ 
 
This folder contains all of the administrative files for the GA TL project running from June 2010 to 
Dec 2011 
The files in this folder are either sourced from the TL government, various stakeholders or are 
outputs of the project. If outputs are present in this folder the methodology for creating them is also 
here. 
 
The names and sources/methodology for creation are as follows: 
 
OverallRoadScore 
ALGIS - Raster - Shapefiles, map of major roads for country 
 
admin_districts folder 
ALGIS - Vector - Administrative (DNGRA also has copy of some of these), admin and manage 
boundaries for country, e.g. districts, subdistricts, sucoscountry national boundary, etc. all polygons 
and a made map which is the boundary map for mainland Timor-Leste 
 
chc new 
ALGIS - Vector - Infrastructure - Health Facilities - CHC New, point data set, not sure what chc 
stands for but assuming list of new and/or existing hospitals, attribute table very detailed, includes. 
number of staff, specialities, morbidity numbers and reasons, issues for the hospital, etc. 
 
hp and mo neww 
ALGIS - Vector - Infrastructure - Health Facilities - HP&MC, point data set, not sure what hp and 
mo neww stands for but assuming it’s a kind of health facility, attributes include name, district, 
owner and whether chc certified 
 
hpt and cl fix 
ALGIS - Vector - Infrastructure - Health Facilities - HPT&CL, point data set, not sure what hpt and 
cl fix stands for but assuming it’s a kind of health facility, attributes include name, owner, staffing 
numbers and types and hospital equipment (eg. x-ray capabilities) 
 
2002schools 
ALGIS - Vector - Infrastructure (DNGRA also has copy), point data set, lists schools, names and 
types 
 
roads and tracks 
ALGIS - Vector - Infrastructure (DNGRA also has copy), line data set, shows all roads for TL - 
descriptions range from two lane sealed road down to foot tracks 
 
hamlets 
ALGIS - Vector - Settlements (DNGRA & Property and Justice also has copy), point data set, shows 
the place and name of hamlets across TL 
 
househlold_points2004 
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ALGIS - Vector - Settlements, point data set presumably from the 2004 census, shows the locations 
of all the houses in TL and the number of people in each house 
 
major towns 
ALGIS - Vector - Settlements (DNGRA & Property and Justice also has copy), point data set, shows 
the place and name of all of the major towns in TL 
 
minor towns 
ALGIS - Vector - Settlements (DNGRA & Property and Justice also has copy), point data set, shows 
the place, name (names the subdistrict and district as well) of all of the minor towns in TL 
 
 
PPJ_Atlas folder 
Stats, THIS FOLDER CONTAINS NO GIS DATASETS, this folder has copies of the 2004 
population census reports, but none of the gis datasets produced from the 2004 census. Statistics 
would prefer if we didn't use any of the 2004 data as they have just completed a more 
comprehensive 2010 census in July, the results of which we should be able to have access to by 
January or February 2011. 
 
 

 
 
 
README for ‘climate’ 
 
This folder contains all of the climate files for the GA TL project running from June 2010 to Dec 
2011 
The files in this folder are either sourced from the TL government, various stakeholders or are 
outputs of the project. If outputs are present in this folder the methodology for creating them is also 
here. 
 
The names and sources/methodology for creation are as follows: 
 
wat6_3 
From ALGIS - Nicholas'08, looks like some kind of water balance/run off polygon area need to 
check with  
Luke, may be useful for recharge. 
 
annual rainfall 
ALGIS - Vector - Climate, basic rainfall contour map for whole of country - fairly large contours 
 
average temp 
ALGIS - Vector - Climate, basic temperature contour map for whole of country, again fairly large 
contours 
 
CMORPH folder 
ALGIS - Vector - Weather station dt, has raster maps of world precipitation for every data from 
2003 to 2008 - the folder with the separate 2008 data also has averaged weekly world precipitation 
maps. These maps were created by John Janowiak and Tim Love of NOAA but unsure for what 
purpose. The files are all in zipped folders - to access, unzip and import into ArcMap (or other 
program that can read GRID format) 
 
Agriculture_WeatherStation 
Meteorologic_WeatherStation 
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(both) ALGIS - Vector - Weather station dt - WeatherStation, both are point data sets that show the 
location and name of various weather stations - no indication when this map was from or if they are 
still active. 
 
100908 HYDATA 
DNGRA, WILL NEED HYDATA PROGRAM TO ACCESS, shows river and rain gauge data that 
Norwegians have collected 
 
Rainfall Data 
DNGRA, EXCEL SPREADSHEETS, contains files on weather stations around country - each file 
shows every, or most, days of the month recording temp, precip, humidity, evaporation, etc. Years 
range from 2004 - 2009 BUT not all years/months are recorded at every station, some only have one 
or two years 
 
rain_temp 
Polygon Shapefile. Compiled/made by Samantha Dawson in December 2010 as part of the 
groundwater recharge site identification study. Map is based on both the annual rainfall and annual 
temperature maps. It is a combination of these two maps divided into each of the separate areas of 
temperature range and rainfall range. 
To produce this map the following method was used: 
First the average temperature shapefile was copied and split so that there were 5 separate shapefiles 
depicting each of the 5 temperature ranges - make a copy of the original shapefile, rename it to the 
temperature range for that shapefile, then in ArcMap 
Open Attribute table (right click on shapefile name > select 'Open Attribute Table') 
Then in attribute table - select 'Options' button > select 'Select by Attributes 
In the window that opens double click on the title of the attribute that you are interested in (e.g. 
temperature range) 
Then click the '=' sign once 
Click the 'Get Unique Values' button then double click on the particular attribute that you want in the 
new file 
Then click 'Apply' 
This will select all of those attributes in the Attribute Table 
Then Select the 'Options' button > select 'Switch Selection' 
This will select everything but the attributes you are interested in 
Then go to the Editor Toolbar (to add to ArcMap go to View > toolbars > select 'Editor') and select 
'Start Editing' 
Right click on the left hand column of the attribute table on any of the selected rows, then click 
'Delete selected' 
This will delete everything except the ones you are interested in 
Go back to Editor Toolbar - select 'Save Edits' > select 'Stop Editing' 
The shapefile will now only show the polygons that you are interested in (e.g. only the temperatures 
for that range) 
Repeat this procedure for each of the 5 ranges. 
Then, using each of the 5 temperature shapefiles in turn, clip the annual_rainfall shapefile - by 
clipping the annual rainfall file by each of the temperature ranges the areas are being divided up by 
rainfall range and temperature range. To clip the rainfall file the following steps were used: 
In the toolbox (if not displayed then press the little red box in the options at the top of ArcMap or 
ArcCatalog) 
Select Analysis Tools 
Select Extract 
Select Clip 
In the window that opens in the Input Features put what you want clipped, in this case the 
annual_rainfall 
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In the Clip Features put what you are clipping by, in this each of the temperature range shapefiles 
(note: you can only do one of these shapefiles at a time)  
In the Output Feature Class, type a name of the new file (in this case probably use a combination of 
rain and the temperature range 
This procedure should produce 5 new shapefiles, each of which contain the annual_rainfall polygons 
that are within a certain temperature range. 
Then for each of the polygons depicting a rainfall range within a certain temperature range, the 
temperature range needs to be added to the polygon. To achieve this use the following steps for each 
of these 5 shapefiles: 
In the attribute table use the 'Options' menu, then select 'Add Field' 
Then in the window that appear give a name for the new attribute (in this case 'temp.' or similar) 
Note: keep the title of the fields the same for all 5 shapefiles 
In type select 'Text' 
Leave the default of others (if longer may need to increase length) 
Click 'OK' 
Then start and Edit session (Editor toolbar - Editor menu > select 'Start Editing' 
Then in the attribute table right click on the heading of the field that was just made 
Select 'Field Calculator' 
In the window that appears, down the bottom in the box that is titled '(name of field) =' write the 
temperature range with inverted commas on each side (e.g. "25 - 27") 
Once this is completed for each of the 5 shapefiles, you can merge the 5 shapefiles into one which 
will have one field/column in the attribute table which is rainfall range and another which is 
temperature range 
To merge the shapefiles use the following method: 
In the Toolbox: 
Data Management Tools > General > Merge 
In the window that appears - in the 'Input Datasets' select the 5 shapefiles (will have to select one at a 
time) 
Then give a name for the Output Dataset give a name for the file (e.g. rain_temp) 
In the Field Map section will be several field names but there should be only one for rainfall range 
and one for temperature range (if you have not used the same names to as titles in the attribute fields 
this will not be the case and you will have to go back and change them) 
Once this is done select 'OK' 
This output from this merge will be a map that is a combination of the rainfall and temperature 
maps. 
 
 

 
 
 
README for ‘earth_obs_img’ 
 
This folder contains all of the earth observatory image files for the GA TL project running from June 
2010 to Dec 2011 
The files in this folder are either sourced from the TL government, various stakeholders or are 
outputs of the project. If outputs are present in this folder the methodology for creating them is also 
here. 
 
The names and sources/methodology for creation are as follows: 
 
Airphoto ecw1 folder 
ALGIS - Raster, airphotos of the whole country (inc. Oecussi and island) to a reasonably fine scale 
digo airphoto index ALGIS - Raster, index for the airphoto folder 
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ECW Rupabumi folder 
ALGIS - Raster, topographic map of the whole country (inc Oecussi and island) 
rupabumi and ecw index ALGIS - Raster, index for the ECW Rupabumi folder 
 
georef space shuttle shaded relief 
ALGIS - Raster - Space Shuttle (DNGRA also have copy), greyscale relief picture of whole country  
(no heights attached) 
 
satellite folder 
ALGIS - satellite, various satellite rasters of either all or parts TL. If 'box' in title only covers a small 
proportion of the country, others cover whole or 3/4 of country. 
 
Aerial folder 
DNGRA, airphotos of whole of country (inc. Oecussi and island) to a reasonably fine scale - seem to 
be the same or similar to airphotos from ALGIS 
 
LANDSAT_742mosaic folder 
ALGIS, Raster dataset - landsat raster to a fairly coarse resolution - shows the country to the East of 
Dili but no further west than the western outskirts of Dili. Also shows landsat for region to the East 
of mainland Timor including PNG and islands further east than PNG 

 
 
 
README for ‘elevation’ 
 
This folder contains all of the elevation files for the GA TL project running from June 2010 to Dec 
2011 
The files in this folder are either sourced from the TL government, various stakeholders or are 
outputs of the project. If outputs are present in this folder the methodology for creating them is also 
here. 
 
The names and sources/methodology for creation are as follows: 
 
erodible2 
From ALGIS - Nicholas'08 folder, country divided into two types polygon; high erodibility and no 
data - could be used to identify areas of high run-off 
 
timor2 
From ALGIS - Nicholas'08 folder - elevation raster, not sure of source 
 
Bathymetry_Sandwell 
ALGIS - SRTM, Bathymetric raster map of the world, inc TL 
 
SRTM_Elevation 
ALGIS - SRTM, elevation raster of whole country - probably best one to use 
 
slopes 
ALGIS - Vector - Elevation, polygon map of whole country divides areas into a slope of S, F or M 
(assuming steep, flat or medium) polygons are large and coarse 
 
elevation 
ALGIS - Vector - Elevation (DNGRA also has copy), polygon map which divides elevation into 7 
categories (presumably lowest to highest but no info on size of categories/division of heights) 
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100m contours 
ALGIS - Vector - Elevation (DNGRA also has copy), contour map of elevation in 100m height 
intervals (whole country) 
 
bath_timor 
ALGIS - Vector - TL, contour map of bathymetry around whole of TL and region. Contours are at 
depth intervals of (m) 0, 100, 200, 500, 1000 and then every 500m to 4500 
 
extract_srtm2 
This raster is based on the SRTM_ Elevation.tif file. It contains the same information except it is 
clipped to the Timor-Leste mainland border (using the clip tool - Analysis Tools > Extract > Clip) 
and a file with the boundary to clip it. It is also in an ESRI grid format instead of .tif 
 
MRVBF folder 
This folder contains the extract_srtm2 (the SRTM_Elevation file but clipped to Timor Leste and in 
an ESRI grid) and the results (and ArcInfo tools) from a MrVBF script (Valley Bottom Flatness). 
This data will be used in the recharge analysis to help identify areas where there is high run off, or 
pooling that would be conducive to recharge. There are a number of rasters produced from MrVBF, 
which there is not room to go into here, however if you consult the literature (John Gallant, CSIRO) 
then it will be able to give more information. 
 
 

 
 
 
README for ‘hydrogeology’ 
 
This folder contains all of the hydrogeology files for the GA TL project running from June 2010 to 
Dec 2011 
The files in this folder are the main outputs for the project. For more information on the project 
please see the fact sheet/reports in the Reports folder 
 
The names and sources/methodology for creation are as follows: 
 
hydgeo_1: 
This is the first attempt at a hydrogeology map for East Timor. It uses the ETGeol10LL as a basis. 
From this, Dr. Luke Wallace assigned each of the types of geologic units in the attribute table an 
aquifer type (karst, sedimentary or fractured rock), a potential yield (high or low) and then gave a 
general rock type description. 
These three attributes were then input into the hydgeo_1 attribute table using these steps in ArcMap: 
In the editor toolbar click the drop down menu than start editing (select correct file) 
Open the attribute table (right click on file name) 
Use an SQL query (click options then 'select by attributes') then use this tool to select all of a 
particular geol unit (e.g. "GEOL_UNIT" = 'Edl' use the buttons and the 'get unique values' to 
select units) 
Then use the field calculator (right click on column you want to add attributes to, select Field 
Calculator) to insert the attributes you want (e.g. in the 'aquifer' column to insert 'fractured rock' into 
all of the Pzlc Geol_Units). In the field calculator select Type: String then in the equation area write 
the words you want inserted into the column in quotation marks e.g. "fractured rock". Make sure the 
'Calculate selected records only' is selected. Then click 'OK'. 
 
When you are finished inserting attributes into the table make sure you go back to the editor toolbar 
and using the dropdown menu select 'save edits' and then 'stop editing'. 
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hydgeo_clip1: 
This is the hydrogeology map except it has been 'clipped' to delete West Timor from the map (which 
was classified as 'NA') so that this hydrogeology map only shows the East Timor mainland. This was 
achieved using a shapefile that was the administrational boundary of East Timor and the Clip Tool as 
below: 
In the Arc Toolbox select Analysis Tools > Extract > Clip. When the window opens use the drop 
down arrow or folder to select the hydgeo_1 map in the 'Input Features' box, then the same process 
to select the admin boundary in the 'Clip Features' box and then rename the file in the 'Output 
Feature Class' box to desired name (note: do not use the same name as any of the input files and try 
to keep at 10 letters or less). Click 'OK'. 
 
hydgeo_2: 
This is a revised version of the hydgeo_1. In this shapefile some of the original added attributes were 
changed and some new attributes were added. For example, the karst aquifers were changed to 
Fractured Rock, high yield aquifers and further attributes, such as amount descriptions, map symbol, 
lithology new, etc. these were added under instruction from Dr. Wallace who assigned these new 
attributes in an excel spreadsheet. The process was the same as for hydgeo_1 
 
hydgeo_2_Dis 
This shapefile is the same as the hydgeo_2 shapefile except it has been processed using the 
following tool. 
Data Management Tools > Generalization > Dissolve using  the input and output files were given 
names and then the fields to dissolve selected were aquifer_type pot_vol (potential volume). This 
tool then takes all polygons that have the same characteristics in those two fields and dissolves/takes 
away the lines between them. This means that when this map is displayed it can be done with 
boundaries around the edge that don't interfere with the internal polygon making the map clearer and 
more readily understandable. 
 
hydgeo_2_ras 
Raster Map. Based on the hydgeo_2 map, this is a raster of a field that was created that combined 
Aquifer with Potential Volume (add a field to the attribute table outside of an edit session then in an 
edit session use the field calculator to make the new column equal the sum of the two previous 
columns). It was created to input the hydrogeology map into 3D format in ArcScene. It was created 
using the convert features to raster in the spatial analyst toolbar (in the toolbar). To get this toolbar 
go to View > Toolbars > (tick) Spatial Analyst. When the toolbar appears click on the drop down 
menu > Convert > Features to raster. In the box that pops up select the input shapefiles/features and 
the Field (attribute column) that you want the raster to be based on (note: none of the other fields 
will be in the output) leave the Output cell size as default and change Output raster to the required 
name. This raster can then be added to an Arcscene map and use a DEM (such as SRTM) as the 
input base heights. 
 
hydgeo_2_lith.lyr 
Layer file based on hydgeo_2. Layer files are used to hold the colours/patterns of a shapefile that 
you have designated in ArcMap. In this case each of the lithologies (e.g. sedimentary, conglomerate, 
karst, etc) of the hydgeo shapefile were displayed in patterns according to the UN International 
Standards. These patterns overlay the hydgeo aquifer map. To save a shapefile to a layer file in 
ArcMap, first make sure the colours that you are displaying the shapefile in are correct. Then right 
click on the shapefile, select 'Save as Layer File', designate name (if different from default), select 
save. 
A layer file only holds the display properties for that shapefile. It is not a shapefile in itself and does 
not store the locations/shapes. It references back to the original file for its information - the original 
file MUST stay in exactly the same folder or be moved in conjunction with the layer file or the layer 
file WILL NOT WORK. 
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If a layer file is not working you may need to re-set where the polygon is - follow the prompts and 
select the correct file. Layer files can also be used to colour other shapefiles the same way as the 
layer file. For example, if a shapefile has some of the same attributes as the layer file based shapefile 
has, you can use these attributes to display in the correct colours, rather than going back to the 
beginning and re-colouring all the attributes by hand. 
 
hydgeo_2a.lyr 
Layer file based on hydgeo_2. Layer file holding the correct colours to display the aquifers of 
Timor-Leste. For example - high sedimentary = dark blue, low sedimentary = light blue. Made using 
process descirbed in hydgeo_2_lith.lyr 
 
aq_pot_ras 
Raster map. Based on the aquifer potentiality map. Aquifer potentiality map is essentially hydgeo 
map but coloured light blue and dark blue. Light blue represents rocks that are aquifers but with low 
prospectivity, dark blue represents rocks that are aquifers with a high prospectivity. This was made 
into 3d using the same methods as the hydgeo_2_ras. It was made so that the raster produced could 
be used in ArcScene to display these polygons in 3d - draped over topography. 
 
ETGeol_attributes_TL_Hydgeo_LW ( ,2,3) 
These are the excel spreadsheets (updated in consecutive numbers) that have the information on how 
the geology was interpreted into geology for the standard map and into hydrogeology. The plain 
cells are the original information from ETGeol files, the cells coloured yellow are the information 
used in the geology file and the blue cells are the interpretation into hydrogeology files 
 
Fissured 
Polygon shapefile. Shows the Fissured rock aquifers (previously called karst aquifers) for the 
mainland of Timor-Leste only (not including SE corner).  
Based on the hydgeol_4 map (most up to date as 12/01/11) uses the SQL and editing tools to delete 
the other polygons from the original shapefile. Instructions as follows: 
In ArcCatalog make a copy of the base shapefile and rename the copy to desired name (e.g. 
Fissured) 
Add new shapefile to ArcMap 
Open Attribute table (right click on shapefile name > select 'Open Attribute Table') 
Then in attribute table - select 'Options' button > select 'Select by Attributes 
In the window that opens double click on the title of the attribute that you are interested in 
Then click the '=' sign once 
Click the 'Get Unique Values' button then double click on the particular attribute that you want in the 
new file 
Then click 'Apply' 
This will select all of those attributes in the Attribute Table 
Then Select the 'Options' button > select 'Switch Selection' 
This will select everything but the attributes you are interested in 
Then go to the Editor Toolbar (to add to ArcMap go to View > toolbars > select 'Editor') and select 
'Start Editing' 
Right click on the left hand column of the attribute table on any of the selected rows, then click 
'Delete selected' 
This will delete everything except the ones you are interested in 
Go back to Editor Toolbar - select 'Save Edits' > select 'Stop Editing' 
The shapefile will now only show the polygons that you are interested in (e.g. only fissured aquifers) 
 
Fissured_Oec_Ata3 
Polygon shapefile. Shows the fissured rock (karst) aquifers of Oecussi and Atauro only. Made by the 
same process as Fissured. 
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Based on the hydgeo for Oecussi and Atauro, which was based on the geology for each island (see 
geology folder). 
 
Fissured_whole2 
Polygon shapefile. Shows the fissured rock aquifers (previously called karst aquifers) for whole of 
Timor-Leste, including Atauro and Oecussi and SE corner. Based on the Fissured and 
Fissured_Oec_Ata3 shapefiles (see above for shapefiles and how they were made). Made by 
merging the two shapefiles it was based on using following steps: 
In ArcMap open/show the toolbox 
Data Management Tools > General > Merge 
In the window that opens select the two shapefiles you wish to merge 
Give a name for the output dataset 
Set other options as required (rest were default for this shapefile) 
Select 'OK' 
 
hydgeo_3 (shape and layer files) 
Polygon shapefile and layer file based on this with aquifer colours. This shapefile is the progressed 
version 3 hydrogeology map from hydgeo_2. It is a hydrogeology map, based on the files and using 
the same processes as the hydgeo 2. As understanding of the Timor-Leste system and the manner in 
which the maps were going to be presented, the files were updated. Older files are kept so that they 
can be used a s a reference in the future. Please refer to hydgeo_2 for the steps involved in updating 
the hydrogeology maps as they are similar for hydgeo_3. 
 
hydgeo_3_Dis 
Polygon shapefile. Based on hydgeo_3 (version 3 of the hydrogeology map). This map shows the 
aquifer types but with the interior boundaries dissolved, making only one polygon for each of the 
aquifer types. The process to make this file was the same used for hydgeo_2_Dis. Please refer back 
to this file for the method used. 
 
hydgeo_3_ras 
Raster file. Based on hydgeo_3_Dis (version 3 of hydrogeology map). This map is the 
hydgeo_3_Dis shapefile but in a raster format. It was put in this format so that it could be displayed 
in ArcScene, draped over the topography.  
For methods on how this was made please refer back to the hydgeo_2_ras details. 
 
hydgeo_4 (shapefile and layer file) 
Polygon shapefile and layer file based on this with aquifer colours. This shapefile is the progressed 
version 4 of the hydrogeology map. Based on hydgeo_3 but with changes made as understanding 
and knowledge increased. As well as changes to the attribute table and categorisation of the data 
there were two other major changes in this file: first there was the inclusion of Atauro, Oecussi and 
the SE corner - done by merging the new hydgeo with the files using the 'merge' tool as follows: 
In ArcMap open/show the toolbox 
Data Management Tools > General > Merge 
In the window that opens select the shapefiles you wish to merge 
Give a name for the output dataset 
Set other options as required (rest were default for this shapefile) 
Select 'OK' 
The other major change was dividing sedimentary aquifers that were connected that should not have 
been. For example, some of the polygons that showed a high yielding, large sedimentary aquifer also 
had bits of the polygon that went higher up into the river valleys, meaning that some parts of the 
same polygon should be classed as high yielding sedimentary and others as low yielding 
sedimentary. To correct this based on a visual (over computer using ArcMap and  
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ArcScene) assessment of the parts of each polygon, taking into account width, predicted depth, 
steepness of slope, etc, the polygons were edited to divide them into the separate aquifer types, 
where necessary. For this editing the following steps were used: 
Editor Toolbar - drop down menu 
Select 'Start Editing' 
Select 'Snapping' 
In box that opens up, for the shapefile that you are working on, tick 'vertex' and 'edge' and 'end' - this 
means that if the mouse is near a vertex, edge or end of the shapefile you have selected it will 
automatically go to that point, this helps to ensure that the shapefile is correctly made and the 
polygons match exactly, it reduces human error significantly and reduces time spent editing. 
In the 'Target:' window make sure the file you wish to edit is selected 
Then use the select tool (arrow/mouse shape next to the Editor drop down menu) 
Select the particular polygon you wish to edit - the edges will turn bright blue 
In the 'Task:' window, under 'Modify Tasks', select 'Cut Polygon Features' - this will divide the 
polygon into two along the desired line exactly - with no gaps between the polygon - it is the 
quickest, most effective way to do this and produces the best results 
Then select the pencil tool (next to the select tool) 
When the mouse is on the map now it will look like a cross-hairs with a circle 
Starting at one edge of the polygon (the tool should snap to it), draw a line across where you want 
the polygon to be split (Note: you do not have to trace the outside edge of the polygon, just draw a 
line where you want the split) 
When you have got to the end of the line you want the split to go along, double click on the opposite 
edge of the polygon - this will place the final vertex and finish the drawing.  
The polygon will then split into two 
As both polygons are selected you can go in to the attribute table of the shapefile and make changes 
to it as necessary (e.g. change the 'high potential yield' attribute for the desired polygon to 'low 
potential yield'. 
When finished use the Editor toolbar to select 'Save Edits' and then 'Stop Editing' 
It is recommended that when making many edits to save the edits regularly in case of 
problems/system crash 
The above steps are how the polygons in the hydrogeology map were edited. 
 
hydgeo_4_dis 
Polygon shapefile. Based on hydgeo_4 (4th version of the hydrogeology map) this essentially the 
same polygon dataset but with all of the internal boundaries of the aquifer types dissolved. See 
hydgeo_2_dis for further details and methods 
 
hydgeo_4_lith.lyr 
Layer file. Based on hydgeo_4 lithologies. This layer file holds the patterns for the lithologies of 
hydgeo_4 in the international standard format (changed a little from version 3). For details and 
methods on how this was made see hydgeo_2_lith.lyr 
 
hydgeo_4_ras2 
Raster file. Based on hydgeo_4_dis it is these polygon but in a raster format so that they can be 
displayed in ArcScene draped over topography. For details and methods see hydgeo_2_ras 
 
hydgeo_clip1 
Polygon shapefile. Based on the hydgeo 4 but also includes the SE corner of mainland Timor-Leste, 
which was not in hydgeo_3 due to lack of data. Made so that the hydrogeology of the SE corner 
could be added (merged with) the hydgeo_4 map. Made using the admin dataset of the mainland 
 
hydgeo_SEcorner 
Polygon shapefile. Based on the geology of the SE corner, which was taken from the same map as 
the Oecussi geology map, shows the hydrogeology of the SE corner that was later merged with the 
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hydgeo_4 shapefile so that the whole of the country was covered in the hydrogeology map. This 
geology file was not based on the ETgeol but another geology shapefile - see the geology_SEcorner 
shapefile for more details. 
 
Intergran 
Polygon shapefile. Shows the Intergranular aquifers (previously called sedimentary or alluvial) for 
mainland Timor-Leste only (not including SE corner). 
Based on the hydgeol_4 map (most up to date as 12/01/11) uses the SQL and editing tools to delete 
the other polygons from the original shapefile. Details and methods/instructions are the same as were 
used in the Fissured shapefile 
 
Intergran_Oec_Ata3 
Polygon shapefile. Shows the intergranular aquifers (previously called sedimentary or alluvial) of 
Oecussi and Atauro only. Made by the same process as Fissured. 
Based on the hydgeo for Oecussi and Atauro, which was based on the geology for each island (see 
geology folder). 
 
Intergran_whole2 
Polygon shapefile. Shows the intergranular aquifers (previously called sedimentary or alluvial) for 
whole of Timor-Leste, including Atauro and Oecussi and SE corner.  
Based on the Intergran and Intergran_Oec_Ata3 shapefiles (see above for shapefiles and how they 
were made). Made by merging the two shapefiles it was based on using following steps: 
In ArcMap open/show the toolbox 
Data Management Tools > General > Merge 
In the window that opens select the two shapefiles you wish to merge 
Give a name for the output dataset 
Set other options as required (rest were default for this shapefile) 
Select 'OK' 
 
Local_aquifer 
Polygon shapefile. Shows the localised aquifers (previously called fractured rock) for mainland 
Timor-Leste only (not including SE corner). 
Based on the hydgeol_4 map (most up to date as 12/01/11) uses the SQL and editing tools to delete 
the other polygons from the original shapefile. Details and methods/instructions are the same as were 
used in the Fissured shapefile 
 
Local_aquifer_Oec_Ata3 
Polygon shapefile. Shows the localised aquifers (previously called fractured rock) of Oecussi and 
Atauro only. Made by the same process as Fissured. 
Based on the hydgeo for Oecussi and Atauro, which was based on the geology for each island (see 
geology folder). 
 
Local_aquifer_whole2 
Polygon shapefile. Shows the localised aquifers (previously called fractured rock) for whole of 
Timor-Leste, including Atauro and Oecussi and SE corner. Based on the Local_aquifer and 
Local_aquifer_Oec_Ata3  
shapefiles (see above for shapefiles and how they were made). Made by merging the two shapefiles 
it was based on using following steps: 
In ArcMap open/show the toolbox 
Data Management Tools > General > Merge 
In the window that opens select the two shapefiles you wish to merge 
Give a name for the output dataset 
Set other options as required (rest were default for this shapefile) 
Select 'OK' 
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Local_confin 
Polygon shapefile. Shows the localised confining layers/rock (previously called fractured rock) for 
mainland Timor-Leste only (not including SE corner). 
Based on the hydgeol_4 map (most up to date as 12/01/11) uses the SQL and editing tools to delete 
the other polygons from the original shapefile. Details and methods/instructions are the same as were 
used in the Fissured shapefile 
 
Local_confin_Oec_Ata3 
Polygon shapefile. Shows the localised confining layers(previously called fractured rock) of Oecussi 
and Atauro only. 
Made by the same process as Fissured. 
Based on the hydgeo for Oecussi and Atauro, which was based on the geology for each island (see 
geology folder). 
 
Local_confin_whole2 
Polygon shapefile. Shows the localised confining layers (previously called fractured rock) for whole 
of Timor-Leste, including Atauro and Oecussi and SE corner. Based on the Local_confin, 
Local_confin_Oec_Ata3 and hydgeo_SEcorner shapefiles (see above for shapefiles and how they 
were made). The hydgeo_SEcorner only had this type of aquifer/confining layer so this was the only 
time it was used in the merge. 
Made by merging the two shapefiles it was based on using following steps: 
In ArcMap open/show the toolbox 
Data Management Tools > General > Merge 
In the window that opens select the two shapefiles you wish to merge 
Give a name for the output dataset 
Set other options as required (rest were default for this shapefile) 
Select 'OK' 
 
 

 
 
 
 
README for ‘hydrology’ 
 
This folder contains all of the hydrology files for the GA TL project running from June 2010 to Dec 
2011 
The files in this folder are either sourced from the TL government, various stakeholders or are 
outputs of the project. If outputs are present in this folder the methodology for creating them is also 
here. 
 
The names and sources/methodology for creation are as follows: 
 
braiding riverbeds 
ALGIS - Vector - hydrology (DNGRA also has copy), polygons (maybe need to see if a line version 
is required) of braided river beds (almost all major rivers in TL are braided rivers) - no rivers named 
 
rivers 
ALGIS - Vector - hydrology (DNGRA also has copy), lines of rivers, almost all feed into the braided 
river beds - no rivers named 
 
seamask 
ALGIS - Vector - hydrology, one polygon outlining sea areas for whole of country/region 
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waterbodies 
ALGIS - Vector - hydrology (DNGRA also has copy), polygons of the waterbodies (there are few 
water bodies in TL) no waterbodies named 
 
watersheds 
ALGIS - Vector - hydrology, polygons of the watersheds in TL - covers whole of country, attributes 
include catchment name, size in hectares and class (eg small catchment, aggregate catchment) 
 
 

 
 
 
README for ‘interperative_geology’ 
 
This folder contains all of the interpretive geology/geology files for the GA TL project running from 
June 2010 to Dec 2011 
The files in this folder are either sourced from the TL government, various stakeholders or are 
outputs of the project. If outputs are present in this folder the methodology for creating them is also 
here. 
 
The names and sources/methodology for creation are as follows: 
 
GeoFormation: 
ALGIS - Raster - Shapefiles, basic geology map, reasonable detail, several copies 
 
GeoStabilityZone: 
ALGIS - Raster - Shapefiles, same polygons as basic geology map but description based on 'stability' 
of polygon - probably made to feed into the landslide map 
 
geology 
ALGIS - Vector - Earth Sciences (Property and Justice also gave a copy) basic polygon geology map 
- descriptions on formation name, age, facies, lithology, thickness, fossils remarks and map symbols. 
Believed to based on the ESCAP maps as the polygons roughly match up and those geological units 
without information (e.g. have a map symbol but that map symbol is not in the key of the ESCAP 
map) are the same for both maps 
 
soils 
ALGIS - Vector - Earth Sciences, basic polygon soil map - divides soils into 'greatsoil' eg 
Calciustolls, 'suborder' eg Ustolls and 'orders' eg Mollisols 
 
ETGeolv10LL 
DNGRA - timor aerial-topo, best geology (polygon) map available, would seem to be a combination 
of four other geology maps; Audley-Charles, Berry, Tobing and MTA (not sure where MTA comes 
from yet - paper's from others all in references folder). It has  much finer detail than other geology 
map, and what would seem to be much more accurate classifications and polygons. Attributes 
include Geol unit, age, group, formation, lithology and geol codes - which is similar to others but 
this has many more, and more descriptive classes, including dividing the recent alluvial into 
alluvium, beach sands, flood plain, lacustrine and river terrace. Believed to be a combination of 
mainly Audley-Charles work for the majority of the area, Berry's work for the northern 
metamorphosed areas and Tobings updates to Audley-Charles work. Possibly compiled by Tobing or 
another of his colleagues during Indonesian times. 
 
 
 

24 



Catalogue of Timor-Leste datasets and data records 

ETGeol_clip 
This is the ET geology map except it has been 'clipped' to delete West Timor from the map (which 
was classified as 'NA') so that this hydrogeology map only shows the East Timor mainland. This was 
achieved using a shapefile that was the administrational boundary of East Timor and the Clip Tool as 
below: 
In the Arc Toolbox select Analysis Tools > Extract > Clip.  
When the window opens use the drop down arrow or folder to select the hydgeo_1 map in the 'Input 
Features' box,  
then the same process to select the admin boundary in the 'Clip Features' box and  
then rename the file in the 'Output Feature Class' box to desired name (note: do not use the same 
name as any of the input files and try to keep at 10 letters or less).  
Click 'OK'. 
 
ETGeo_stcol 
This is the ET geology map except that it has been put into international/Australian colours (or as 
close as it was possible to get to them. To do this, Dr. Wallace analysed the data and assigned map 
symbols, further geology descriptions. 
These were then added to the attribute table using the 'Add Field' tool and then in an edit session 
using SQL queries to select relevant files and then the field calculator to insert the new attributes. 
The map symbols were then used as the display category and each map symbol was given a colour 
based on the Australian and international standards as advised by Alan Whittaker. To find the exact 
colours used please refer to the excel spreadsheet in this file. They are in RGB base. 
 
 
ET_Geol_ras 
Raster Map. Based on the EtGeo_stcol map this is a raster of the Map Symbols column. It was 
created to input the geology map into an 3D format in ArcScene. It was created using the convert 
features to raster in the spatial analyst toolbar (in the toolbar).  
To get this toolbar go to View > Toolbars > (tick) Spatial Analyst.  
When the toolbar appears click on the drop down menu > Convert > Features to raster.  
In the box that pops up select the input shapefiles/features and the Field (attribute column) that you 
want the raster to be based on (note: none of the other fields will be in the output), leave the Output 
cell size as default and change Output raster to the required name.  
This raster can then be added to an Arcscene map and use a DEM (such as SRTM) as the input base 
heights. 
 
A0 
Nat_Res, THIS MAP IS NOT DIGITISED, this is the map from Natural Resources  where only hard 
copies exist.DSmeone from Perth (one person from a Uni and another from a company) took 
pictures of it and were going to try and digitise it (visited Natural Resources in Feb/March) but 
haven't heard back from them. Need to chase up to see if they were successful 
 
ETGeo_stcol##.lyr 
(1a,2,2a,2b,3) 
Layer files based on ETGeo_stcol. These are layer files which house the different versions and 
colourings for the geology map of Timor-Leste. These maps are layer files, which means they do not 
hold any polygon data or information in the shapefile, they only hold the display properties (e.g. how 
it was displayed and what colours were used) of the ETGeo_stcol map. They refer back to the 
original file in order to display. If the original base file is removed the layer files will need to be 
redirected to refer back to it. The numbers in the title refer to the different versions of the map as 
colours, map symbols and understanding of the geology increased. The higher the number the more 
up to date the version is. The colours used in the layer file are also stored in RGB and shadeset 
numbers in the excel spreadsheet in this file. They are based on both the Australian and international 
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standards and were developed in consultation with Alan Whittaker, who was part of the team that 
made the Australian geology map.  
To make a layer file display the base file in ArcMap > adjust the display setting and colours to where 
desired > right click on the title of the shapefile in the left hand box listing the files > click on 'Save 
as Layer 
File' > give a name to the new file (or leave as default) > click 'Save'. This will create the new layer 
file. You can also, in the Properties, display window, use layer files to apply this symbology/display 
settings to other shapefiles with some of the same attributes (e.g. if you had a shapefile of West 
Timor geology and the rock types/map symbols used corresponded with those in Timor-Leste you 
could use these ETGeo_stcol layer files to display all of the rock types in the same colours so that 
the two different maps would match in display properties. 
 
ETGeol_attributes_standard_colour.xlsx 
Excel spreadsheet. This spreadsheet houses the attribute table from the original ETGeolv10LL file 
plus the coloured columns which are the interpretations, colours, changes made and the same for the 
extra units of the Atauro and Oecussi maps. The interpretations were made by Dr. Luke Wallace as 
part of this project and included assigning map symbols. The colours are in line with Australian and 
international standards, they are stored here as RGB and GA Shadeset values.  
If the layer files are lost or corrupted this file can be used to source the correct colours for the map. 
The cells with a yellow background refer to geology and those with a blue background refer to 
hydrogeology interpretations. The cells with no background are from the original attribute table. Of 
the geology interpretation cells (yellow) the ones titled R, G, B and HP refer to the colours used in 
the layer files. Those called Solo R, Solo G, Solo B and Solo HP refer to a map where only some of 
the geology was displayed (to be specific the intergranular aquifer geology map), as the original 
colours given to these geology types was very light they needed to be darkened slightly, just for this 
one map, so that they would be visible on a white background map (GA standard for maps is a white 
background). This spreadsheet is the most up to date version as of January 2011. 
 
geo_who2_ras ( ,2,3) 
Raster files. These maps are based on the map symbols of the ETGeo_stcol most up to date 
shapefile. The numbers represent the detail in the map/cell size. The higher the number the more 
detailed the map and the smaller the cell size is. This was to find the best balance between 
computing time and display quality. Rasters of these shapefiles were made so that they could be 
displayed in ArcScene in a 3d Format and draped over the topography.  
The process for making these maps is as follows: 
It was created using the convert features to raster in the spatial analyst toolbar (in the toolbar).  
To get this toolbar go to View > Toolbars > (tick) Spatial Analyst.  
When the toolbar appears click on the drop down menu > Convert > Features to raster.  
In the box that pops up select the input shapefiles/features and the Field (attribute column) that you 
want the raster to be based on (note: none of the other fields will be in the output).  
In these versions the first file was with the output size left as the default and this cell size was then 
decreased with successive rasters. note: the colours of the shapefile do not get carried across to a 
raster and applying the layer file does not work so the colours need to be reassigned. 
 
geology_Atauro 
Polygon shapefile. This geology map is based on the geology map in the Atauro folder (see below 
for details). It is essentially a copy of this map but it has extra attributes added for the new map 
symbols (to match in with the ETGeo_stcol mainland map and, for new geological units, to match in 
with Australian and International standards) and for more information on how the geology was 
interpreted plus the hydrogeology information assigned to the various geological units. This map 
then provided the base for the input in the geology_whole2 map and the hydgeo_atauro (see 
hydrogeology file). The assigned attributes were based on the interpretations listed in the 
EtGeol_attributes_standard_colour.xlsx.  
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To insert this information into the attribute table a similar method was used as for the ETGeo_stcol 
map: 
To do this Dr. Wallace analysed the data and assigned map symbols and further geology 
descriptions. 
These were then added to the attribute table using the 'Add Field' tool and then in an edit session 
using SQL queries to select relevant files and then the field calculator to insert the new attributes. 
The map symbols were then used as the display category and each map symbol was given a colour 
based on the Australian and international standards as advised by Alan Whittaker. 
This geology map is for Atauro only but was used to merge with the other geology maps to make the 
whole of country geology map 
 
geology_Oecussi 
Polygon shapefile. Based on the geology shapefile (not sure of source of geolgoy shapefile). This 
shapefile was used as the ETGeolv10LL did not cover this area. This file was clipped from the 
geology shapefile using the Oecussi border polygon in the admin&infra folder (In the toolbox - 
Analysis tool > Extract > Clip). And then, similar to the ETGeo_stcol, the geological map units were 
assigned a new map symbol, differently formatted geology information and hydrogeological 
information. Note: some the geological units in this map did not have any information apart from 
age - these are the sections that are marked as 'Unknown's in the map - this is because it is believed 
that this map is based on the ESCAP map - which has some areas where the geological units are not 
defined. This is the most up-to-date version of geology for Oecussi that was possible to use. This 
shapefile was also used for the hydrogeology 
 
geology_SEcorner 
Polygon shapefile. The ETGeolv10LL (based on work done by Audley Charles and others) does not 
cover the SE corner of Timor-Leste (a roughly triangular shape 13km by 15km) Therefore this area 
also used the geology shapefile as a source of geology. To make it was a similar process to the 
geology _Oecussi and the same issues apply: 
Based on the geology shapefile (not sure of source of geology shapefile). This shapefile was used as 
the ETGeolv10LL did not cover this area. This file was clipped from the geology shapefile using the 
Oecussi border polygon in the admin&infra folder (In the toolbox - Analysis tool > Extract > Clip). 
And then, similar to the ETGeo_stcol, the geological map units were assigned a new map symbol, 
differently formatted geology information and hydrogeological information. Note: some the 
geological units in this map did not have any information apart from age - these are the sections that 
are marked as 'Unknown's in the map - this is because it is believed that this map is based on the 
ESCAP map - which has some areas where the geological units are not defined. This is the most up-
to-date version of geology for SE corner that was possible to use. This shapefile was also used for 
the hydrogeology. 
 
geology_SEcornerMapSymbol 
Polygon shapefile. Based on geology_SEcorner this is essnetially the same map except that the 
attribute table only contains the original and the new map symbols. This was created so that it could 
be easily merged with the other geology maps to make the whole of country map. 
 
geology_whole2 
Polygon shapefile. Based on ETGeo_stcol, geology_Atauro, goelogy_Oecussi and 
geology_SEcorner, this is a merged copy of all of those files. The only attributes it contains are the 
assigned map symbols and in the case of the Atauro, Oecussi and SEcorner there are the map 
symbols from the original files. These were included so that they are noted and where there are 
unknowns they can be easily differentiated from each other. In order to merge shapefiles the 
following steps were taken: 
In the toolbox - Data Management Tools > General > Merge 
then select all of the data sets you want to include 
give the output dataset a name (or leave as the default) 
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In the 'Field Map' box all of the attribute column titles will appear - select only those attributes you 
want merged 
(note - if there are columns of attributes in different shapefiles that need to be in the same column in 
the new shapefile then they will need to have the same name - either that or use the 'Field Calculator' 
to merge the two columns into a new third one once the new shapefile is made - but designating the 
same name from the beginning is easier to process and less complex and confusing later. 
Then select 'OK' 
In this case the output was a geology map that covers the whole of Timor-Leste, including Atauro, 
Oecussi, SEcorner. 
This map also uses a consistent map symbol labelling (designated by the project). It is therefore used 
in the output of a new geology map for Timor-Leste. Maps previous to this are difficult to obtain, do 
not cover the whole area and in the case of GIS do not have metadata so no background information 
can be ascertained. 
 
geology_whole2_fissured 
Polygon shapefile. Based on the geology_whole2 shapefile, this map only has the geology for the 
areas that have been designated as being fissured aquifers (previously called karst). This shapefile 
was made for a map in the hydrogeology report to demonstrate the geological characteristics of the 
karst aquifers. This map was made by taking the geology_whole2 and then clipping it using the 
fissuerd_whole2 (see hydrogeology folder) as a the clip polygon. 
Then all that was left were only those areas that were designated as fissured aquifers. To use the clip 
tool: 
In the toolbox - Analysis Tools > Extract > Clip 
In the window that opens select the file you want clipped (geology_whole2), then the clip features 
(fissured_whole2) then give an output name or leave default. For this project rest was left in default 
but can be adjusted as necessary. 
 
geology_whole2_intergran 
Polygon shapefile. Based on the geology_whole2 shapefile, this map only has the geology for the 
areas that have been designated as being intergranular aquifers (previously called sedimentary). This 
shapefile was made for a map in the hydrogeology report - to demonstrate the geological 
characteristics of the karst aquifers.  
This map was made by taking the geology_whole2 and then clipping it using the Intergran_whole2 
(see hydrogeology folder) as the clip polygon. 
Then all that was left were only those areas that were designated as intergranular aquifers. To use the 
clip tool: 
In the toolbox - Analysis Tools > Extract > Clip 
In the window that opens select the file you want clipped (geology_whole2), then the clip features 
(intergran_whole2) then give an output name or leave default. For this project rest was left in default 
but can be adjusted as necessary. 
 
geology_whole2_LocAquif 
Polygon shapefile. Based on the geology_whole2 shapefile, this map only has the geology for the 
areas that have been designated as being localised aquifers (previously called fractured rock, high 
yield). This shapefile was made for a map in the hydrogeology report to demonstrate the geological 
characteristics of the karst aquifers.  
This map was made by taking the geology_whole2 and then clipping it using the 
Local_aquifer_whole2 (see hydrogeology folder) as the clip polygon. 
Then all that was left were only those areas that were designated as localised aquifers. To use the 
clip tool: 
In the toolbox - Analysis Tools > Extract > Clip 
In the window that opens select the file you want clipped (geology_whole2), then the clip features 
(local_aquifer_whole2) then give an output name or leave default. For this project, therest was left in 
default but can be adjusted as necessary. 
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geology_whole2_LocConfin 
Polygon shapefile. Based on the geology_whole2 shapefile, this map only has the geology for the 
areas that have been designated as being localised aquifers (previously called fractured rock, low 
yield). This shapefile was made for a map in the hydrogeology report to demonstrate the geological 
characteristics of the karst aquifers.  
This map was made by taking the geology_whole2 and then clipping it using the 
Local_confin_whole2 (see hydrogeology folder) as the clip polygon. 
Then all that was left were only those areas that were designated as localised aquifers. To use the 
clip tool: 
In the toolbox - Analysis Tools > Extract > Clip 
In the window that opens, select the file you want clipped (geology_whole2), then the clip features 
(local_confin_whole2) then give an output name or leave default. For this project, the rest was left in 
default but can be adjusted as necessary. 
 
ATAURO FOLDER: 
 
This folder contains all of the data given to the GA project team by Kim Ely who did research on the 
geology of the island under Mike Saniford of University of Melbourne. It was sent to GA on the 7th 
Dec 2010. The most recent version of that map was at that time being prepared for publication in the 
journal of Earth sciences and it was based on work carried out from 2005 onwards (we believe). 
These files are for the map produced for this work and as there was no metadata attached to them are 
listed to the best of our current knowledge.  
 
data1 Folder 
This folder contains two other folders which contain three ArcMap files and one .pdf file, all of 
which are maps of Atauro geology. The ArcMap files source the shapefiles in the Atauro folder - if 
these maps are to be used they must be kept with the source data. Although when the data is 
transferred from computer to computer, ArcMap will have to be directed to the location on the new 
computer. 
 
Alt_strong 
Polygon shapefile and layer file. Sourced from Kim Ely, December 2010. Shows areas on Atauro of 
strong alteration. Alteration is a geological process that happens when the rock is underground, 
usually along fractures in a weathering-like way. For more information ask geologist. Polygon 
shapefile stores the areas and layer file stores the display properties chosen by Kim Ely for the map 
she was making. The files need to be kept together for the layer file to work. 
 
Alt_weak 
Polygon shapefile and layer file. Sourced from Kim Ely, December 2010. Shows areas on Atauro of 
weak alteration. Alteration is a geological process that happens when the rock is underground, 
usually along fractures in a weathering-like way. For more information ask geologist. Polygon 
shapefile stores the areas and layer file stores the display properties chosen by Kim Ely for the map 
she was making. The files need to be kept together for the layer file to work. 
 
Atauro_samples 
database (.dbf) and layer file. Presumably holds information on where samples were taken from 
when field work was being conducted on Atauro. Assuming Kim or one of her teams holds more 
info on the samples. Not necessary to find out more information on them for this project. If need 
more information in future contact Kim Ely or Mike Saniford. Database in windows explorer 
operates similar to, and can be viewed by, excel. In ArcGIS it is used as a reference table, similar to 
an attribute table but does not have shapefiles with it. Used to store large quantities of info and 
reference and/or cross reference different shapefiles. Layer file like others described here. 
 
 

29 



Catalogue of Timor-Leste datasets and data records 

Atauro_towns 
Point shapefile and layer file. Sourced from Kim Ely, December 2010. Depicts the points of the 
towns on Atauro.  
Attribute table has names of towns. Point shapefiles houses locations and layer files houses the 
display properties selected by Kim Ely for map she was producing. 
 
be_manas 
Point shapefile and layer file. Sourced from Kim Ely, December 2010. Shows four points, no 
information in attribute table. After cross-referencing with the text on the map produced shows 
points where hot springs occur on Atauro. Unsure if be_manas is Tetun or Tetun derived word for 
hot springs. Point shapefiles houses locations and layer files houses the display properties selected 
by Kim Ely for map she was producing. 
 
Bedding 
Line shapefile. Sourced from Kim Ely, December 2010. Line shapes on Atauro that indicate the 
direction of bedding of rocks in some areas of Atauro. Used in map that was produced. Attribute 
table states whether the bedding is a strike, dip or flow direction. Line shapefile houses location and 
layer file houses the display properties selected by Kim Ely for the map she was producing. 
 
Faults 
Line shapefile and layer file. Sourced from Kim Ely, December 2010. Shows lines where faulting 
occurs on Atauro. This is needed on geology maps. Digitised during 2005 field trip. In attribute table 
there are two columns, one title 'sense' under this the polylines are either 'normal' or blank, the other 
column is titled 'confidence' in this the majority is blank but one polyline has 'inferred' written in. 
Line shapefile houses location and layer file houses the display properties selected by Kim Ely for 
the map she was producing. 
 
Lithology 
Layer file. Sourced from Kim Ely, December 2010. Based on the Pleistocene sediments-merge 
shapefile - see below. Houses the display properties for this shapefile. Used in the map produced by 
Kim Ely 
 
Pleistocene sediments-merge 
Polygon shapefile. Sourced from Kim Ely, December 2010. Polygons depicting the geology of 
Atauro as used for the map Kim Ely was producing. Has the geology for the entire island and 
attribute table only has one column - the map symbols that were used for this map. For more 
information on what the map symbols mean refer back to the final maps that were produced in the 
data1 folder (particularly the .pdf file). In the legend for this there is more information on each of the 
map symbols and what rock type they are referring back to. 
 
topo_features 
Point shapefile and layer file sourced from Kim Ely, December 2010. Shows three points depicting 
the mountains/ highest points of Atauro. Attribute table holds the names for the mountains. Point 
shapefile houses locations and layer file houses display properties as used in the map produced. 
 
 

 
 
 
README for ‘land_info’ 
 
This folder contains all of the land information files for the GA TL project running from June 2010 
to Dec 2011 
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The files in this folder are either sourced from the TL government, various stakeholders or are 
outputs of the project. If outputs are present in this folder the methodology for creating them is also 
here. 
 
The names and sources/methodology for creation are as follows: 
 
erodible2 
From ALGIS - Nicholas'08 folder, country divided into two types polygon; high erodibility and no 
data - could be used to identify areas of high run-off 
 
high_fertility 
From ALGIS - Nicholas'08 folder, has a number of polygons showing areas of high fertility 
 
land_plan_District 
From ALGIS - Nicholas'08 folder, divides country into a range of polygons identifying both current 
uses and potential/planned future uses 
 
wat6_3 
From ALGIS - Nicholas'08 folder - need to check meaning with Luke 
 
Landcover 
ALGIS - Raster - Shapefiles, country divided into polygons based on land use, shows what land is 
being used for (eg. forest, agriculture, etc) and agriculture subdivided into types and then there are 
obs and comments on some of the land types 
 
soils 
ALGIS - Vector - Earth Sciences, basic polygon soil map - divides soils into 'greatsoil' eg 
Calciustolls, 'suborder' eg Ustolls and 'orders' eg Mollisols 
 
slopes 
ALGIS - Vector - Elevation, polygon map of whole country divides areas into a slope of S, F or M 
(assuming steep, flat or medium) polygons are large and coarse 
 
rice fields 
ALGIS - Vector - Land Cover (DNGRA also has copy), polygon map showing various areas where 
rice is grown in TL,  divides between rainfed and irrigated rice - may be useful for calculating 
consumption/knowing irrigation areas 
 
landcoverCopy 
ALGIS - Vector - Land cover, exactly the same as other landcover map; country divided into 
polygons based on land use, shows what land is being used for (eg. forest, agriculture, etc) and 
agriculture subdivided into types and then there are obs and comments on some of the land types 
 
lum_w 
ALGIS - Nicholas '08, Polygon map - divides mainland TL into polygons which divide into areas of 
Agriculture, Agroforestry/grazing, Forest/Agroforestry and no data (for areas outside mainland TL) 
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README for ‘natural_habitat’ 
 
This folder contains all of the natural habitat files for the GA TL project running from June 2010 to 
Dec 2011 
The files in this folder are either sourced from the TL government, various stakeholders or are 
outputs of the project. If outputs are present in this folder the methodology for creating them is also 
here. 
 
The names and sources/methodology for creation are as follows: 
 
BVA 
ALGIS - Raster - Shapefiles, seems to be either protected areas or potential protected areas/high 
biodiversity 
 
ESM 
ALGIS - Raster - Shapefiles, division of country into very high, high, med & low sensitivity (no 
other info) 
 
ImportantBirdArea 
ALGIS - Raster - Shapefiles, polygons of areas which are of high importance to birdlife 
 
Landcover 
ALGIS - Raster - Shapefiles, country divided into polygons based on land use, good detail on 
landuse, particularly agricultural sub-divisions 
 
Timor_Coastal_Marine_Habitats_Nth 
ALGIS - Timor_Coastal_Marine_Habitats_Nth, North coastline (and just off coastline) divided into 
marine habitats e.g. sand beach, mangrove forest, etc. 
 
 

 
 
 
README for ‘non_dig_maps’ 
 
This folder contains all of the non digitised map files (rasters or jpegs of maps that only hard copies 
exist of also not geo-referenced) for the GA TL project running from June 2010 to Dec 2011 
The files in this folder are either sourced from the TL government, various stakeholders or are 
outputs of the project. If outputs are present in this folder the methodology for creating them is also 
here. 
 
The names and sources/methodology for creation are as follows: 
 
ALGIS folder - 
The maps in this folder are all from ALGIS. There were no other metadata attached to these maps.  
Names are generally self explanatory  
(Copy on end is brought across from a sub-folder - need to check whether exact copy or not): 
 
afp sample survey 2007 - basic agricultural map 
 
agroclimatic_zones edit2 - divided based on lowland, slope, highland and low, mod high rainfall 
  
annual_rainfall - basic contour rainfall map - same as shapefile from ALGIS (see climate folder) 
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bathymetric - only some of coastline bathymetric contours 
 
Copy of steve_dunn - called 'The Proposed Refrigerator (cold chain) Locations by Sub District' basic 
map with major towns, roads and districts with a few points identified 
 
forest_status - shows areas of settlement and where forest is nature reserve, protection forest, 
convertible production forest, wildlife reserve or recreation park 
 
soil_taxonomy - shows soil categories/groups for whole of country - have similar digitised version 
 
tl_admin_subdist_a0 - shows sub-districts, major towns and roads 
 
 
A0 
Nat_Res, THIS MAP IS NOT DIGITISED, this is the map from Natural Resources  where only hard 
copies exist.DSmeone from Perth (one person from a Uni and another from a company) took 
pictures of it and were going to try and digitise it (visited Natural Resources in Feb/March) but 
haven't heard back from them. Need to chase up to see if they were successful 
 
 

 
 
 
README for ‘recharge’ 
 
This folder contains all of the recharge files for the GA TL project running from June 2010 to Dec 
2011 
The files in this folder are either sourced from the TL government, various stakeholders or are 
outputs of the project. If outputs are present in this folder the methodology for creating them is also 
here. 
 
The names and sources/methodology for creation are as follows: 
 
Water_balance_method Folder: 
 
This folder was created because using the water balance equation was one of the methods used in 
attempting to find recharge. This equation is as follows: 
D = P - RO - ET - deltaW 
where: 
D = Deep drainage/recharge 
P = Precipitation 
RO = Run Off 
ET = Evapotranspiration 
delatW = change in water soil storage 
For this equation we used the annual rainfall map from ALGIS, the ADB water report for Run Off 
and to get ET we used the Blanley-Criddle method using the ALGIS meteorological data to source 
the average temperature info. 
The following method was used: 
We based the test runs on the surface water catchments used in the Run Off report as there was no 
other way to  apply the run off numbers. Made a copy of the surface water catchments shapefile 
from ALGIS and then deleting all other polygons except for the catchment we were working on to 
get boundary. Used this and the clip tool (Analysis Tools > Extract > Clip) to clip the rainfall 
shapefile to the catchment size. First the clipped file needed to be reprojected into a mercator format. 
Then in the new clipped file,in the attribute table added a new field called area (Options > add field). 
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Then in an edit session right click on the area field and click calculate geometry. In property select 
area and then select area and then in the units option select Square meters. 
In an excel table (see the ones in the Laclo and Loes test runs) use the areas and the median for that 
rainfall range (in meters) times together to calculate annual rainfall in m3 (m2 for area and m deep 
for rainfall). Then the ADB run off report was used to find the annual run off for that catchment (in 
MCM - million cubic meters). 
This then gave the P-RO by minus the RO number from the P number calculated. To find ET the 
Blanley-Criddle method was used. The equation is as follows: 
ET = k * p * (0.46 * Ta + 8.13) 
where: 
k = plant consumptive coefficient - a number between 0.5 (orange trees) to 1.2 (dense natural 
vegetation) and represents the plant use of water, we used a k of 0.85 and then 0.65 
p = percentage of daylight hours - in this case it was assumed there were 12 hour days as it is close 
to the equator so therefore the equation was p=(12*30)*100/(12*365) - although the 30 may change 
depending on how many days there were in that month  
0.46 and 8.13 are constants 
Ta = average temperature - sourced from the ALGIS meteorological data 
This equation was first calculated in months averaged across the years we had data for and then 
these results were added together to give the annual ET in mm. This was then divided by 1000 to 
give the number in m and then multiplied by the area to give the annual ET in m3 which could then 
be put into the equation. 
deltaW was not used in this instance as we were attempting to find out the annual average and it was 
not an event analysis. 
Each of these numbers to put into the water balance equation were calculated in an excel spreadsheet 
and then the number was added under a field in the attribute table of the Run Off/boundary 
shapefiles. Then the a field titled recharge was added to the attribute table and (in an edit session) 
right click on the title of this field and then use the field calculator to produce the recharge figure. 
The numbers produced from this procedure mostly gave a negative number namely due to the large 
ET because the calculation for ET produces potential ET which is not the same as actual ET which 
we do not have the means/data to calculate 
 
 

 
 
 
README for ‘working’ 
 
This folder contains all of the working files for the GA TL project running from June 2010 to Dec 
2011 The files in this folder are the currently being worked on. For more information please see 
source files or ask Sam or Luke 
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Attachment 3: Example of a metadata record from the Timor-Leste project  
 
This is an example of a metadata record that is attached to an ArcGIS file. This example is from one 
file, in this case the first draft of the hydrogeology map (made by the project). Metadata records have 
been completed for both the collected files and the files produced by the project, in total over 100 
files.  
 
(note: some of the unknowns are due to the original data not having metadata, ideally when the data 
is first created this information would be filled out and could then be used for datasets produced 
from this) 
 

 
 
ISO and ESRI Metadata: 

 Resource Information  

 Spatial Representation Information  

 Reference System Information  

 Data Quality Information  

 Distribution Information  

 Metadata Information  

Metadata elements shown with blue text are defined in the International Organization for Standardization's 

(ISO) document 19115 Geographic Information - Metadata. Elements shown with green text are defined by 

ESRI and will be documented as extentions to the ISO 19115. Elements shown with a green asterisk (*) will be 

automatically updated by ArcCatalog.  
 

Resource Information:  

Title: hydgeo_1  
Alternate title(s): hydgeo_1.shp  

Abstract:  
Polygon map - This is the first attempt at a hydrogeology map for East 
Timor. It uses the ETGeol10LL as a basis. From this Dr. Luke Wallace 
assigned each of the types of geologic units in the attribute table an aquifer 
type (karst, sedimentary or fractured rock), a potential yield (high or low) 
and then gave a general rock type description. These three attributes were 
then input into the hydgeo_1 attribute table using the steps in ArcMap as set 
out in the readme.txt in this folder. 
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This map was made by Samantha Dawson in October 2010 as part of the 
East Timor groundwater project at GA. Please see groundwater group for 
any queries or questions 
 
Creation Date: 2010-10  
Revision Date: 2010-10  
*Presentation format: digital map  

Custodian Organisation: External Agency/Company  
Contact's position: various  

Contact information:  
Phone:  
Voice: see Metadata Contact  
Fax: see Metadata Contact  
 
Address:  
Delivery point: see Metadata Contact  
City: see Metadata Contact  
Administrative area: see Metadata Contact  
Postal code: see Metadata Contact  
Country: see Metadata Contact  
e-mail address: see Metadata Contact  
 
Online resource:  
Online Location: see Metadata Contact  
 

Back to Top  
Themes or categories of the resource: inland waters  

Theme keywords:  
Keywords: GEOSCIENCES-Geology, BOUNDARIES-Biophysical, 
GEOSCIENCES-Hydrogeology, WATER-Groundwater, WATER-Supply  

Thesaurus name:  
Title: ANZLIC Search Words  

Revision Date: 2008-05-15  
Edition: Version 2.1  
Edition date: 2008-05-15  

 
*Dataset language: English  

Update Status: onGoing  

Resource constraints:  
Access constraints:  

This dataset essentially belongs to the Timor Leste government, it was made 
by the GA Groundwater Group as part of a groundwater mapping project in 
2010/11. It was made using data sourced from the Timor Leste government 
and will be given back to them along with the other project outputs. 
Although there were no restrictions given by the Timor Leste government on 
the use of their data or the datasets produced from this project the Timor 
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Leste government and Geoscience Australia should be recognised 
appropriately when using this map. For permission to use this map please 
contact Geoscience Australia. 

 
Limitations of use:  

This map is based on another map/s and/or data that was sourced from the 
Timor Leste government. For all of the original data there was no metadata 
or other information attached therefore it's fitness for use outside the 
2010/11 Timor Leste groundwater mapping project by GA is questionable. 
We are uncertain as to data quality, resolution, creation date or methods. 
Therefore the use of this map in other project is not advisable unless no 
other alternative data can be used and the limitations/error factor of this 
data should be recognised. 

 
*Spatial representation type: vector  

Spatial resolution:  
Dataset's scale:  
Scale denominator: unsure  
 

Resource's bounding rectangle:  
*Extent type: Full extent in decimal degrees  
*Extent contains the resource: Yes  
*West longitude: 123.268126  
*East longitude: 127.343306  
*North latitude: -8.322121  
*South latitude: -10.371934  
 

Dataset point of contact:  
Organisation: Geoscience Australia - Groundwater Group, GEMD  
Contact's position: Divisional Information Manager - GEMD  

Contact information:  
Phone:  
Voice: 1800 800 173  
Fax: (02) 6249 9999  
 
Address:  
Delivery point: GPO Box 378  
City: Canberra  
Administrative area: ACT  
Postal code: 2601  
Country: Australia  
e-mail address: sales@ga.gov.au  
 
Online resource:  
Online Location: http://www.ga.gov.au/sales  
 

Back to Top  
 

Spatial Representation - Vector:  

*Level of topology for this dataset: geometry only  
Geometric objects:  
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*Name: hydgeo_1  
*Object type: complexes  
*Object count: 1922  
 

Back to Top  
 

Reference System Information:  

Reference system identifier:  
*Value: GCS_WGS_1984  

Back to Top  
 

Data Quality Information:  

Lineage:  
Polygon map - This is the first attempt at a hydrogeology map for East 
Timor. It uses the ETGeol10LL as a basis. From this Dr. Luke Wallace 
assigned each of the types of geologic units in the attribute table an aquifer 
type (karst, sedimentary or fractured rock), a potential yield (high or low) 
and then gave a general rock type description. These three attributes were 
then input into the hydgeo_1 attribute table using  the steps in ArcMap as 
set out in the readme.txt in this folder. 
  
This map was made by Samantha Dawson in October 2010 as part of the 
East Timor groundwater project at GA. Please see groundwater group for 
any queries or questions.  
  
As this is the beginning of the project there will be modifications to this map 
in the near future. We are unable to say at the moment how often the 
dataset will be updated post-project. 

 
Source data acknowledgements:  
Data quality report - Absolute positional accuracy:  
 

Unable to ascertain 
 

Data quality report - Attribute accuracy:  
 

Unable to ascertain 
 

Data quality report - Conceptual consistency:  
 

Unable to ascertain 
 

Data quality report - Completeness:  
 

Unable to ascertain 
 

Back to Top  
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Distribution Information:  

Distributor's name: Geoscience Australia  
Contact's position: Sales Office  

Contact information:  
Phone:  
Voice: +61 2 6249 9966  
Fax: +61 2 6249 9960  
 
Address:  
Delivery point: GPO Box 378  
City: Canberra  
Administrative area: ACT  
Postal code: 2601  
Country: Australia  
e-mail address: sales@ga.gov.au  
 
Online resource:  
Online Location: http://www.ga.gov.au/sales/  
 

Distribution format:  
Format name: ArcGIS layer file  

Transfer options:  
*Transfer size: 20.745  

*Online Location: 
file://\\Nas2\gemd\water\Projects\East_Timor_groundwater\Data\GIS_work
ing\hydrogeology\hydgeo_1.shp  
Available As: Departmental Data  
 

Back to Top  
 

Metadata Information  

*Metadata language: English  
*Metadata character set: utf8 - 8 bit UCS Transfer Format  

Last update: 2010-10-15  

Metadata contact:  
Organisation: Geoscience Australia - Groundwater Group, GEMD  
Contact's position: Divisional Information Manager - GEMD  

Contact information:  
Phone:  
Voice: 1800 800 173  
Fax: (02) 6249 9999  
 
Address:  
Delivery point: GPO Box 378  
City: Canberra  
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Administrative area: ACT  
Postal code: 2601  
Country: Australia  
e-mail address: sales@ga.gov.au  
 
Online resource:  
Online Location: http://www.ga.gov.au/sales  
 

*Scope of the data described by the metadata: dataset  
*Scope name: dataset  

Name of the metadata standard used: ANZLIC Metadata Profile  
Version of the metadata standard: 1.1  

Metadata identifier: 6BF06A72-12CE-473D-A431-6C7ADBB3B821  

Back to Top 
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